Jargon busting
DLNA, LAN, WLAN, 802.11x, WAN, whaaa...?

What can be networked around you?
NAS boxes, your phone, gaming consoles and much more

Just sharing a net connection?
For those who just want the basics

Set up your own network
Not just at home, but on the go as well

Advanced home networking
Guide to using DLNA, media servers and virtual networks

Networking and beyond
Networking apps for Android and iOS
TP-LINK 150Mbps Wireless Solutions

150Mbps Wireless N ADSL2+ Modem Router
TD-W8931ND
- 3-in-1: ADSL2+, modem, NAT router, and wireless N access point in one device provides a one-stop networking solution

150Mbps Mini Wireless N USB Adapter
TL-WN723N
- OS: Windows 7 32/64bit, Vista 32/64bit, XP 32/64bit

150Mbps Wireless N Router
TL-WR740N
- WDS Wireless Bridge provides seamless bridging to expand the wireless network

150Mbps Wireless N USB Adapter
TL-WN721N
- OS: Windows 7 32/64bit, Vista 32/64bit, XP 32/64bit
Copper and Fiber Cabling Solutions

Belkin structured cabling solutions utilize quality components and advanced manufacturing techniques to ensure consistent, top-quality network performance. All Belkin cables are guaranteed to meet or exceed industry standards and come with a lifetime warranty.

Features:
- Compliant to EIA/TIA 568 C.2 & ISO/IEC 11801 standards
- UL-certified CAT5e and CAT6 LAN cables
- Meets all alien crosstalk reduction specifications

QUALITY
Belkin products are designed, tested, and proven to perform in environments where reliability is critical.

SERVICE
Belkin responds quickly to every support call with expert assistance, answers to your questions, and solutions to your problems.

INNOVATION
Belkin anticipates your needs, developing innovative products designed for your industry when you need them.

belkin.co.in
For enquiries, SMS Belkin to 54646
Toll free number: 1800-419-5546 or email IndiaMarketingSupport@belkin.com

2011 Belkin International, Inc All rights reserved. Features and specifications are subject to change without notice. All trade names are registered trademarks of respective manufacturers listed.
NETWORKING EVERYTHING
Jargon busting
MAN, PAN, SAN, WLAN, CAN, WAN, DAN - learn about all these terms used in the world of networking. Then reacquaint yourself with the technologies involved in connecting you to the rest of the world or even to your baby brother.

What can be networked around you?
The answer is tablets, smartphones, consoles, hubs, switches, routers and access points. Read on to know how...

Just sharing a net connection
Sharing is caring or so think these networked devices. Let these simple steps teach you how to hook up laptops or laptops and phones to one another - wirelessly (read: Wi-Fi) and with wires (read: LAN and USB)

Setting up your network
Not just at home, but on the go as well. Acquaint yourself with data cards and tethering among other wonderful things.
Advanced home networking
The geek guide to using DLNA, media servers and virtual networks at home. Ever wanted to keep a watch on your home while you were away? Find out how you can.

Networking and beyond
Networking apps for Android and iOS that every geek should know about. Security measures you should take to protect against remote users.
Introduction

Kickstart your journey to the world of networking by taking a look at what this edition of Fast Track promises to cover

If historians were entrusted with the task of identifying the most influential and ubiquitous word that has defined the last couple of decades – it would undoubtedly be “networking”. Be it computer networks or social networks, you can’t escape the ever-reaching tentacles of networking – and why would you want to?

With the host of gizmos that have flooded the consumer electronics market, there’s an ever-increasing need for interconnectivity. An average working professional has a plethora of gadgets at his disposal – a PC for office work, an office smartphone (perhaps a BlackBerry), a personal
iPhone or an Android phone, an iPod for his music and, maybe even, a tablet or laptop at home. The list doesn’t end there – don’t forget gaming consoles, media players and wireless data cards among other things. This raises a very pertinent issue – how do you make the same data available on all devices? After all, in this inter-connected world, you might want to download a movie via your smartphone on an old PC at home, then create a backup on your NAS box and finally stream it on your widescreen TV. In this edition of Fast Track, we’ll show you how to do this and much more.

Come join us as we introduce you to the complex-sounding jargon within Networking and demystify them for you. We’ll give you a brief idea about the various technologies used for communication and the principle behind their working – so that you’ll be able to stand your ground in front of those computer nerds we all know. We’ll also show you the different avenues that are available to us to network various devices in unimaginable ways. After reading the step-by-step guide to internet sharing, you’ll find that sharing an internet connection between two laptops or between your laptop and phone was never easier. And if sharing the plain old internet isn’t enough, this Fast Track is a complete tutorial on how to set up your own network with Wi-Fi routers, wireless cards and even tethering. By the time you finish this book, you’ll be able to convert your home into a futuristic world, where you’ll remotely control all your gadgets over a wireless network.

So what are you waiting for? Let’s get started and explore the wonders of networking.
If you’ve heard someone talking about network communication, you must have definitely come across words such as LAN, WLAN, DLNA etc. Have you ever felt left out of the conversation because you didn’t know what they meant? Another question coming up. Have you ever
wondered how your cell phone communicates? This chapter will take a term-by-term approach and familiarise you with all the technologies used in the field of communication.

First, we’ll start off by explaining different kinds of networks and their uses. Then we’ll explain the different technologies such as Bluetooth, Wi-Fi, etc., used for communication and how they work. Moving beyond networks we’ve also explained how your cell phone communicates and how Global Positioning System, which helps you in navigation, works.

**Types of networks**

**LAN (Local area networks)**

This network covers a small area such as a school, office or a building. It’s usually set up to share files, internet and printers and to play multiplayer games. Local area networks are easy to build and maintain. The simplest LAN is two computers connected by an ethernet cable (commonly referred to as “LAN Cable”). Multiple computers can be connected to the LAN using a network hub. Multiplayer games can be played by building a temporary LAN which is commonly called a LAN party.

**WLAN (Wireless local area network)**

As the name suggests, this network provides the same kind of connectivity as LAN without the cables. It uses radio signals to communicate. Your device must be Wi-Fi enabled to connect to a WLAN.
WAN (Wide area network)

Unlike LAN or WLAN, WAN spans a large area such as a city or a country. This is made possible by connecting smaller networks like LAN to each other. The best example of WAN is the internet, which is the world’s biggest WAN. Besides the internet, large businesses and governments use WAN to relay information to their clients and colleagues.

MAN (Metropolitan area networks)

These networks span a large area like a city or a large campus. MANs usually interconnect a number of LANs and provide building blocks for WAN.

SAN (Storage area network)

SAN is a type of local area network (LAN) designed to handle large data transfers.

PAN (Personal area network)

This is your very own personal network. Personal area networks typically involve a mobile computer, a cell phone and/or a handheld computing device such as a PDA or an iPad. You can use the network to transfer files between your devices, sync your calendar etc. Personal area networks can be constructed with cables or wirelessly.

CAN (Controller area network)

This is a network of microchips which can communicate with each other without a host computer. It was designed specifically for automotive applications but is now also used in other areas such as industrial automation and medical equipment.
12 | JARGON BUSTING

**DAN**
Desk area network (DAN) is an architecture for a multimedia workstation that is based around an ATM (Asynchronous Transfer Mode) interconnect. ATM is a name given to very high speed networking protocols. This architecture allows multimedia devices to be connected to the network instead of the workstation.

**Technologies**

**DLNA (Digital Living Network Alliance)**
When people started networking home entertainment devices, it was difficult and confusing to add a new device and get it to communicate with their computers and other network devices. There was a need for standards and guidelines for home networking media devices. So, several manufacturers got together to create a standard so that all of their products were compatible in a home network and thus the Digital Living Network Alliance (DLNA) was born in 2003.

When a device is DLNA certified it can connect to other DLNA certified devices irrespective of the manufacturer of the product. DLNA certified devices can: find and play movies; send, display and/or upload photos; find, send, play and/or download music; and send and print photos. DLNA uses Universal Plug and Play (UPnP) for media management, discovery and control so they require little or no setup and can be immediately connected to your existing DLNA network.

**CEC (Consumer Electronic Control)**
One of the biggest challenges of technological revolution is creating intelligent devices that can communicate with each other. The CEC technology brings us one step closer to the dream. CE (consumer electronic) devices can automatically configure themselves and correct errors without user intervention. Using the HDMI framework, CEC takes user experience to a whole new level. For example, you can connect your camcorder to your CEC-enabled HDTV and the TV will automatically detect the device and display it on the screen. You can now control your camcorder with your CEC-enabled HDTV. Same goes for DVD players and set-top boxes; you don’t need to switch remotes when you use different devices. Unlike DLNA, interportability is an issue here. You can control devices only if they have the same manufacturer.
**Bluetooth**

The simplest and most common way for two handheld devices to communicate with each other is via Bluetooth. Bluetooth networking transmits data via low-power radio waves. It communicates on a frequency between 2.402 GHz and 2.480 GHz. This frequency band has been set aside by international agreement for the use of industrial, scientific and medical devices (ISM). Bluetooth devices send out weak signals of about 1 milliwatt to avoid interference with other devices such as computers and cell phones. This low power, however, limits its range to 10 metres, but its signal can pass through walls so direct line of sight is not required.

Another great advantage of Bluetooth is that it can connect up to eight devices simultaneously without interference. It uses a technique called “spread-spectrum frequency hopping” which, put in simple words, means it keeps changing its frequency in the designated range and thus interference, if any, lasts for a fraction of a second and goes unnoticed.

Like any wireless network, security is a concern with Bluetooth. The automatic nature of the connection which makes it easy to use can also be used against you by sending you data without your permission. To avoid this, Bluetooth offers several security modes, and device manufacturers determine which mode to include in a Bluetooth-enabled gadget. When any other device tries to establish a connection to the user’s gadget, the user has to decide whether to allow it. If you use the device quite often, you can mark the device as “trusted” and it will be able to exchange data without permission.

Inspite of all the security measures, there are certain Bluetooth specific problems.

- **Bluejacking:** Bluejacking is sending text messages or audio/video files to a person without his permission. Although harmless, it can make the user think that his phone is malfunctioning.
- **Bluebugging:** Bluebugging is a more serious problem. It allows hackers to use your phone’s features, for example by placing calls or sending messages without the user realising it.
- **Car Whisperer:** Car Whisperer is a piece of software that allows hackers to send audio to and receive audio from a Bluetooth-enabled car stereo.
**Infrared**

One of the many uses of Infrared technology is short range communication. It uses an infrared spectrum of light which is invisible to the naked eye. The device is fitted with infrared light-emitting diodes (LEDs) to emit infrared radiation which is focused by a plastic lens into a narrow beam. The beam is modulated, i.e. switched on and off, to encode the data. The receiver uses a silicon photodiode to convert the infrared radiation to an electric current. It responds only to the rapidly pulsing signal created by the transmitter, and filters out slowly changing infrared radiation from ambient light. It doesn’t penetrate walls and so can’t interfere with other devices in adjoining rooms. Before the Bluetooth technology, mobiles exchanged data using infrared but now the most common application of infrared technology is your everyday remote control.

**Wi-Fi**

Although the Wi-Fi technology has been around since 1985, it was widely used only after 1997. Wi-Fi or Wireless Fidelity is actually a play on words with Hi-Fi. It’s a trademark of the Wi-Fi Alliance and the brand name for products using the IEEE 802.11 family of standards.

Wi-Fi has made it cheaper and easier to create local area networks in places where cables cannot be run. As the price of chipsets for Wi-Fi continues to drop, manufacturers are building wireless network adapters not only into laptops but also into cell phones and other handheld devices.

Like all wireless technologies, Wi-Fi uses electromagnetic waves to communicate. They are transmitted at frequencies of 2.4 GHz or 5 GHz. This frequency is considerably higher than the frequencies used for cell phones, walkie-talkies and televisions. The higher frequency allows the signal to carry more data and thus make it faster than Bluetooth or Infrared.

Wi-Fi uses 802.11 networking standards, which come in several variants:

- **802.11a**: Released in September 1999, it transmits at 5 GHz and can move up to 54 megabits of data per second. It also uses a more efficient
coding technique called orthogonal frequency-division multiplexing (OFDM) that splits that radio signal into several sub-signals before they reach a receiver. This greatly reduces interference. It has an approximate range of 35 m.

- **802.11b**: Released with 802.11a, 802.11b is the slowest and the least expensive standard. 802.11b transmits in the 2.4 GHz frequency band of the radio spectrum. It can handle up to 11 megabits of data per second. Its low cost made it popular but its popularity has reduced since newer standards offer better speeds at lower prices.

- **802.11g**: 802.11g was released in June 2003 and transmits at 2.4 GHz like 802.11b, but at a higher speed of 54 megabits of data per second. 802.11g is faster because it uses the same OFDM coding as 802.11a.

- **802.11n**: This is the latest standard and was released in October 2009. It transmits at 2.4 GHz using OFDM technique and offers speeds up to 150 megabits per second.

Wi-Fi has undergone many overhauls because of security concerns. Wired Equivalent Privacy (WEP) encryption was designed to protect against casual snooping but it’s no longer considered secure. Because of WEP’s weakness the Wi-Fi Alliance approved Wi-Fi Protected Access (WPA). Though more secure than WEP, WPA has known vulnerabilities. The more secure WPA2 using Advanced Encryption Standard was introduced in 2004 and is supported by most new Wi-Fi devices.

**RFID**

Radio-frequency identification (RFID) is a technology that uses radio waves to transfer data from an electronic tag, called RFID tag or label, to a receiver within the range of a few metres. These RFID tags are small and can be attached to objects to identify and track them.

This technology has been around since 1970 but it was too expensive to be used on a large scale. These tags were expensive because they were inductively coupled RFID tags which had a complex system of metal coils, antennae and glass. Then came the capacitively coupled tags which could be mass manufactured at a significantly lower cost. They used conductive carbon ink instead of metal coils to transmit data. There has also been a considerable decrease in the size of RFID. There are RFID chips as small as 0.05 x 0.05 millimeters.

Every RFID tag works in the same way:
1. Data is stored in an RFID microchip
2. When the tag’s antenna receives electromagnetic energy from an RFID reader’s antenna, the tag sends back radio waves to the reader.

3. These waves are decoded by the reader and data transfer is complete.

There are three types of RFID tags:

- **Active tags:** These RFID tags use internal batteries as a power source. They have a range of around 30 m which can be boosted to 100 m by using additional batteries.

- **Semi-passive tags:** They too have batteries but are only activated in the presence of a reader.

- **Passive tags:** Passive RFID tags rely entirely on the reader for power. They use the electromagnetic energy of the radio waves emitted by the reader. They are small in size and cheaper to manufacture. Because of the limited power source, they have a short range of 6 m.

RFID technology was originally meant to replace bar codes. This could potentially save thousands of man hours spent waiting in lines for check out. With RFID tags, you could just walk out of the store and the reader would automatically bill you for the products you’ve shopped.

It’s currently being used to track livestock. This is done by fitting animals with location-tracking RFID chips. Pets are also being implanted with tiny RFID tags containing information about their owners and their medical history. More recently, these RFID tags are implanted in humans. These tags...
contain all the medical history of the person and prove extremely useful for Alzheimer’s patients. However, all hospitals are not equipped with RFID readers rendering the tag useless.

Though RFID is commonly used, it will take considerable technological advancement for it to become an everyday use technology.

**NFC**

Near Field Communication (NFC) technology is a short-range wireless communication. NFC uses RFID communication protocols and data exchange formats. Using this, you can communicate with another NFC device or an unpowered NFC chip, called a “tag”.

This technology is being used in credit cards. The new credit cards are fitted with NFC chips which can be simply tapped against a NFC payment terminal to make payment. NFC is also used to make “smart posters” with embedded NFC chips. Tap your NFC enabled phone against them to get all the information you need about the poster.

Nokia 6131 being used in an NFC transaction

**GSM and CDMA**

To know what GSM and CDMA mean, we must first know how a cell phone works. The mobile phone was devised by combining Alexander Graham Bell’s telephone and the radio invented by Nikola Tesla.
Primitive mobile communication technology consisted of CB radios and walkie-talkies. A CB radio system consists of central antenna with around 20-30 channels and the phone transmits data on a particular channel to the tower which then retransmits it and can be received by any one logged on to that channel. A walkie-talkie is also used for communication but it has a single channel and no tower to retransmit its signal, hence it has a limited range. Both walkie-talkies and CB radios are half-duplex devices. That is, two people communicating on a CB radio use the same frequency, so only one person can talk at a time. That’s why you always hear soldiers saying “over” after they finish their sentence so that the other person can start talking. Also limited number of conversations can take place simultaneously because of the limited number of channels.

On the other hand, a cell phone is a full-duplex device. That means that you use one frequency for talking and a second, separate frequency for listening. Both people on the call can talk at the same time. The cellular system divides the city into small cells (25 sq km) so thousands of people can use their cell phones simultaneously. A cell phone also has considerable large number of channels to communicate. Each carrier in each city also runs one
central office called the Mobile Telephone Switching Office (MTSO). This office handles all of the phone connections to the normal land-based phone system, and controls all of the base stations in the region.

Now that we have a fair idea about the setup of a cellular network, let’s see how a call is placed.

When you turn on the phone, the phone tries to communicate with a specific channel called the control channel. The phone receives a unique identity number called System Identification Code (SID, specific to each network operator) and compares it to the SID programmed into the phone. If they match, it knows that it’s using the home network, if it doesn’t, it’s on roaming. If the phone can’t find any control channels to listen to, it knows it’s out of range and displays a “no service” message.

It also sends a registration request. This way, the MTSO can keep a track of your location in its database. It looks for you in the database when you get a call.

The MTSO then selects a frequency pair on which you’ll communicate and using the control channel tells your phone to use these frequencies. Once your phone and the tower switch on those frequencies, the call is connected.

If you’re travelling you’re bound to change cells. As you move closer to the edge of a cell, your signal strength decreases, meanwhile the tower in the other cell (the one you’re moving closer to) notices that your phone signal strength is increasing. These two towers coordinate with the MTSO and it records that you’ve switched cells.

There are three technologies that are used by network operators to carry out this communication. Although the names look scary, you can break it down to simple parts. The first word tells you what the access method is. The second word, division, lets you know that it splits calls based on that access method. The last part says multiple access which means that more than one user can utilise each cell

- **Frequency division multiple access (FDMA):** FDMA puts each call on a different frequency. It separates the spectrum into distinct voice channels by splitting it into uniform chunks of bandwidth. It’s used for analog transmission but is not considered an efficient method for digital transmission.

- **Time division multiple access (TDMA):** In TDMA, a narrow band (channel) that is 30 kHz wide and 6.7 milliseconds long is split time-wise into three time slots. Each conversation gets the radio for one-third of the time. This is possible because voice data that has been converted to
digital information is compressed so that it takes up significantly less transmission space. Therefore, TDMA has three times the capacity of an analog system using the same number of channels. This technology is used for GSM. GSM systems use encryption to make phone calls more secure.

**Code division multiple access (CDMA):** In CDMA, the data is digitised and spread out over the entire available bandwidth. Multiple calls are overlaid on each other on the channel, with each assigned a unique sequence code. In simple words, data is sent in small pieces over a number of the discrete frequencies available for use at any time in the specified range. At the receiver, that same unique code is used to recover the signal.

What does this mean for you? In terms of connectivity and speeds, there’s not much difference between them. However, in CDMA, there’s no SIM (subscriber identification module) card and so changing your network provider can be a little difficult. In a GSM phone, you can switch networks by simply changing your SIM card. To overcome this drawback, CDMA network providers try to provide better rates and plans.

**GPS**

GPS or Global Positioning System is a satellite navigation system that provides location to any user with a GPS receiver free of cost. The GPS project was developed in 1973 to overcome the limitations of previous navigation systems. GPS is a network of 27 Earth-orbiting satellites maintained by the
Units States of America. They orbit at 19,300 km within a time period of 12 hours. The orbits are arranged in a specific way so that at least four satellites are in the line of sight of the receiver.

For the GPS receiver to receive a signal it should have a clear view of the sky. To understand how GPS calculates your exact location, we must first understand Trilateration. Imagine you know your distance from point A, then you know that you can lie anywhere on a circle centred at A and the radius being your distance from the point. Now suppose you know your distance from another point B; you can infer that you’ll lie on one of the two intersection points of the two circles. If you know your distance from a third point, you can pinpoint your location as the intersection point of the three circles. This is called 2-D Trilateration. If you extend this logic to 3-D, you’ll need your distance from four points. Since you already know your distance from the center of the earth, you need to know your distance from three other points. This information is provided by the GPS satellites.

Every satellite continually transmits messages that include the time at which it was transmitted, its orbital information, its general health and rough orbits of other satellites. When this signal is received by your GPS receiver, there’s a very tiny time lag because of the time taken by the signal to reach the GPS receiver. This lag is used to calculate the distance of the satellite (speed of light x time lag). Since the speed of light is very high, the time lag is very low and to measure this lag accurately the clocks on the satellite as well as the GPS receiver should be synchronised down to the nanosecond. Such high level of accuracy is possible using atomic clocks which are very expensive. Instead of having atomic clocks on the satellite and the receiver, only the satellite has the atomic clock and the receiver contains a simple quartz clock. The receiver calculates its own accuracy by receiving signals for four satellites and corrects itself. Every GPS has stored data of where every satellite should be at what time and using that it can calculate the location. Speed is simply calculated by the change in location divided by time.
Once your location is calculated by the GPS device, it can help you in navigation, traffic updates, weather forecast etc. Any average smartphone has a GPS device and can provide you basic navigation information. There are more sophisticated GPS devices for cars which offer a wider range of features.

**Speeds involved**

We’ve already seen the speeds involved with the different technologies described above. You can compare and contrast the speeds involved in the table.

<table>
<thead>
<tr>
<th>Technology</th>
<th>Speed</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAN</td>
<td>100-1000 Mbps</td>
</tr>
<tr>
<td>Wi-Fi</td>
<td>70-150 Mbps</td>
</tr>
<tr>
<td>RFID</td>
<td>100-400 kbit/s</td>
</tr>
<tr>
<td>Bluetooth</td>
<td>24 Mbit/s</td>
</tr>
<tr>
<td>Infrared</td>
<td>1-4 Mbit/s</td>
</tr>
<tr>
<td>GSM/CDMA (3G)</td>
<td>2 Mbit/s</td>
</tr>
</tbody>
</table>
WHAT CAN BE NETWORKED AROUND YOU?

A closer look at the plethora of consumer electronics available, and ways to seamlessly interconnect them
The consumer goods marketplace is flooded with an array of devices, all capable of networking. This has opened up new vistas, which would have seemed futuristic and far-fetched less than a decade ago. Consumers are spoilt for choice – you can take your pick from among laptops, tablets, smartphones, network-attached storages and consoles. What’s more, you can network them in unimaginable ways! You can access your NAS box from your smartphone and use it to play a movie on your home theatre. In this chapter, we’ll explore the different available avenues out there, for us to network.

**Tablets and smartphones**

Tablet computers serve as a great replacement when you want to read a book, watch some videos or just surf the web. However, just like smartphones, much of the use of tablets is dependent on network connectivity. Therefore every tablet manufacturer provides network connectivity in multiple ways such as through Wi-Fi, Bluetooth etc. You’ll learn how to take advantage of them in later chapters.

**Wi-Fi**

The simplest and the most common way to connect to a network is using the Wi-Fi built into the tablet. With Wi-Fi you can not only connect to your local wireless network, you can also access the net if your network is connected to the internet. You can surf the web at any Wi-Fi hotspot which is now common in malls and coffee shops. Most devices are now shipping with 802.11n Wi-Fi which, as we’ve already seen, is the fastest and most flexible of all the technologies.

**2G/3G**

If you don’t have access to Wi-Fi all the time you should consider a 2G or a 3G internet connection from a mobile network provider. This way you can stay connected anywhere you go. However you will have to pay your service provider too. Most network providers give you the option of choosing between various data plans according to your requirements. There are data plans for 3G as well as 2G but 3G is still pretty expensive in India and 2G is too slow. Although some mobile network operators have started testing 4G networks in India, we still have a long way to go.

**Bluetooth**

We know that Bluetooth technology is primarily a means of connecting
wireless peripherals to mobile devices. This includes items such as keyboards or headsets. This technology can also be used for networking between devices and sharing an internet connection (commonly known as tethering). Tethering is a method of connecting a mobile device such as a laptop, netbook or tablet with a mobile phone or any other mobile device to share the wireless broadband connection. So you can share your internet connection on your phone with your tablet via Bluetooth. We’ll learn how to tether different gadgets in the later chapters.

**Wireless Base Station**
An emerging form of wireless connectivity is Wireless Base Station. It allows an individual to connect a wireless router to a high-speed wireless network such as a 3G network, allowing other devices that have standard Wi-Fi to share that broadband connection. You just have to turn on the device and it connects to your network provider and creates a portable Wi-Fi hotspot to which several devices can be connected. Tata Indicom and MTS currently provide this service in India and charge you around ₹5,000 for the base unit and monthly charges depending on your data plan. However if you use these, you can’t switch your network provider. To have this freedom you need to get a Dlink DIR-457 pocket router. With this you can choose your own network provider, your data plan and switch network providers just by swapping the SIM card in it. You’ll learn how to use this pocket router in the later chapters.

**NAS boxes**
Network Attached Storage (NAS) is a dedicated data storage technology, which can be connected directly to a computer-network in order to provide a centralised data-access and storage to all compatible network-clients. In short a NAS is a standalone file-level computer data storage device, into which you can install one or more internal or external hard disk drives, and then connect the NAS device directly to your network.

The NAS device is given its own IP address. This allows you to configure it to share the hard drives and their data contents on the network to other
What can be networked around you?

With a NAS you do not have to have your computer(s) powered on permanently – your data is always available on your network and easily accessible from multiple devices. It’s also possible to ‘convert’ a modest computer into a dedicated NAS device – we’ll be covering this in the latter chapters.

Four cool ways you can use your NAS

As we can make out, the principle purpose of the NAS, is to store and share files on the network. However, the utility of these cool devices doesn’t simply end here.

There are a loads of other things you can do with your NAS:

- Streaming media to other computers from your NAS

  If you have a home theatre PC, PlayStation 3, Xbox 360, or other UPnP-enabled device, you can stream media straight from your NAS with just a few tweaks.

  The first thing you need to know about is Digital Media Adapter (DMA, also referred to as Digital Media Receiver). DMA provides the most elegant way to share audio, photo, and video files between your PC and your television. The DMA connects to your TV via HDMI, composite or component video outputs; and it connects to your network via ethernet or wirelessly. Once on the network, it can stream media from your network hard drive – assuming the NAS box has an UPnP (Universal Plug and Play) media server embedded, as most of them invariably do. You
can also use a video game console connected to your television, such as the Sony PlayStation 3 or the Microsoft Xbox 360, to stream the media from a NAS to your TV.

In order to complete the circuit, you’ll need a router; preferably one equipped with wireless and wired gigabit ethernet. In most cases, gigabit ethernet provides a smoother playback experience with high-definition content.

NAS boxes with UPnP media servers also offer other media-centric features such as an iTunes server. What this translates into is you can simply store your songs on the drive, and the iTunes server will create a shared iTunes library that shows up automatically under the “Shared” heading of the iTunes navigation panel on your PC, or via your DMA. This little trick saves you the hassle of adding songs to every iteration of iTunes on your network.

**Backing up data to your NAS**

Since a NAS can hold many large drives, it’s a popular option for backing up data. FreeNAS recommends a software called Rsync for backup, but there are better alternatives. Microsoft SyncToy, is a case in point. In case you’re a Mac user, you can use Time Machine with your NAS.

**Backing up with SyncToy**

So if you have to back up a folder or even a group of folders on Windows, you first need to download and install SyncToy. SyncToy is extremely simple to use: all you need to do is create a new folder pair, using the “left” folder as the folder from your computer that you want to back up, and the “right” folder as the folder on your NAS to which you’re backing up those files. You have three different types of sync: Synchronize, Echo and Contribute.

- **Synchronize** will keep the two folders in sync at all times, so if you change or delete something on one side, it will sync those changes to the other side.
- **Echo** will only sync changes you make from the left side (your computer)– if you change or delete anything on the NAS, those changes won’t be synced back.
- **Contribute** does the same thing as Echo, but won’t sync over deletions. This means if you accidentally delete a file from your hard drive, it will still be on the NAS, and you can go grab it and replace it. When you’re done, you can run your first sync and make sure all the files copied over correctly.
SyncToy, unfortunately, only runs when you tell it to, so if we want to automate this process, we’ll have to do it ourselves. Open up your Start Menu and type “task scheduler” into the search box, and start up Microsoft’s Task Scheduler program. Click “Create New Basic Task” in the right sidebar, give it a name and set it to run daily. When asked, tell it you want to start a program. At the next screen, browse into C:\Program Files\SyncToy 2.1 folder and choose “SyncToyCmd.exe”. Type -R into the Arguments box, hit next and finish setup.

**Backing up with Time Machine**

If you want to back up with Time Machine, you’ll need one of the drives in your NAS shared through AFP instead of CIFS. If you do, you can head into Services > AFP > Shares on the web interface, edit the settings for that share, and pick “Time Machine” from the “Automatic Disk Discover Mode” dropdown. The next time you open up Time Machine, your NAS drive will be available as a backup disk.

Note that to do this, you’ll want to mount the NAS drive at logon, which you can do by opening up System Preferences on your Mac, going to Accounts > Login Items and dragging the NAS drive from your desktop right into the login items window. That way it will always be connected and Time Machine will be able to access it at all times.

**Downloading torrents using your NAS**

One of the coolest features of FreeNAS is the ability to download torrents without the help of another computer. FreeNAS has a version of Transmission built right in, that can watch folders for torrents and download them. This means you will never have to worry about keeping your main computer on, being logged in, or avoid rebooting it. Your NAS will automatically download all those torrents for you.

In order to set up BitTorrent support, just open the web configuration of FreeNAS and select BitTorrent from the Services menu. Click the Enable checkbox on the righthand side, and specify a Download Directory. This is where your com-
completed torrents will go. You can also set up a Watch Directory that will allow you to drop torrent files right into a specific folder on your NAS and it will immediately start downloading them. You can save the settings when you’re done.

Using your smartphone or tablet with your network-attached storage

Now comes the interesting part – there will be times when you would want to upload or download files from your network-attached storage device using your smartphone or tablet computer. You may even treat the NAS simply as a network transfer point for your data. In this section we’ll tell you how to use your smartphone with your NAS.

How to do it

When it comes to shifting or syncing multimedia files like music or images, different NAS may follow different methods. Some network-attached storage devices may use a web front for the file collections whereas others may implement certain extensions to DLNA for uploading and downloading some media files. These environments don’t necessarily provide a consistent or ideal user experience for the mobile device user, due to a number of factors. Typically this is due to a web front that is optimised for desktop use only. In certain cases, the DLNA server and client apps may not offer the proper sync or file-transfer functionality.

SMB file-manager apps

The recommended method for this task is the SMB/CIFS network file handling, because of various reasons:

- It’s supported by every network-attached storage device thanks to Linux’s SAMBA software.
- Even the USB-linked file servers support SMB as well as the internet HTTP and FTP file transfer protocols.
- This has been a standard for regular computing devices with the Microsoft Windows Platform, as well as Linux and Apple Macintosh platform, for a long time.

The platform-based mobile devices have joined the SMB party through the use of SMB-enabled file-manager apps. These are typically low-cost or free apps that expose the mobile device’s file system.
and the SMB file shares (entry points) made available by computers or network-attached storages.

Listed below are some of the most popular file manager apps with SMB file transfer below. You can even find more such apps at the various app stores for the popular mobile device platforms by using the terms “SMB file transfer” in your search query.

**iOS (App Store)**
- Intuitive Commander – $0.99
- FileBrowser – $4.49
- Syncsellence – $5.49, free limited version available

**Android (Android Market)**
- ES File Explorer
- File Expert
- File Manager / File Manager HD by Rhythm Software

**BlackBerry (BlackBerry App World)**
- File Expert – $1.99
- File Manager Pro by Terra Mobility – $4.99
- ArrangeIt File Manager by Conceptual Designs – $1.99

It’s also worth noting that your NAS’s vendor may offer file-transfer apps for their device on the iOS and/or Android platforms so you can transfer the files to their device. These programs may also work with the remote-access functionality that some of the consumer and SMB NAS units provide. As a result, one can keep login credentials for the devices and thus streamline the entire remote-access experience.

**Consoles**
Gone are the days when LAN gaming was just for computers. You can now enjoy online gaming with your friends on almost all new gaming consoles. Let’s see how we can network different gaming consoles.

**Online gaming**

**PlayStation 3**
1. Turn on your wireless network and make sure your PlayStation 3 is within range. Make sure that the ethernet cable isn’t plugged into the system.
2. Turn on the PS3 console, go to Settings and select “Network and Settings”
3. Select the Internet Connection Settings tab and the system will display a new screen saying you’ll be disconnected from the internet. Select “Yes”.
4. On the next screen, select “Easy” when the system asks you what kind of installation you want to use.
5. When it asks you what type of connection you have; select “wireless”.
6. Select “Scan” on the next screen and the console will search for all available networks in the area.
7. When it completes scanning, select your home network. Select your security settings, enter your encryption key and save your settings.
8. You can test the connection by selecting the “Test Connection” option. If the connection has been made, your network information will appear on the screen.

Stream media
Do you know that your PS3 can do more than just online gaming? With a few tweaks to your settings, and some software set up on your computer, you can stream music, videos and photos from your computer to your PS3 over your home network.

To do this, make sure your PS3 is connected to the same network (via ethernet or wirelessly) as your computer. Then, on your PS3 go to Settings > Network Settings > Media Server Connection and set it to “Enabled”.

- If you have a PC with Windows
  1. Open Windows Media Player
  2. Go to Library > Add to Library and add folders you want your
PS3 to access. All personal folders (Photos, Videos, and Music) are selected by default, but if you have media in other folders, add them.

3. Go to Library > Media Sharing, and check Share Media. Press OK, your PS3 to show up as one of the devices in some time. Select it and click allow.

- **If you have a Mac**

  You have to install a free software called PS3 Media Server. With this software your Mac will be visible to your PS3

  1. Connect to your network
  2. Go to Navigation/Share Settings and uncheck everything in the Thumbnails section (at the top). Then, at the bottom, add folders you want your PS3 to access. You can choose to add your entire hard drive, but it’s advisable only to add the folders that have media.
  3. Now, go to Transcoding Settings, and change the Maximum bandwidth to 14 or 15. Leave it to 0. If you have a very strong network connection.
  4. Click Save and Restart HTTP Connection

Now that we’re done setting up the computers, it’s time to move on to your PS3:

1. Open the Photos, Videos, or Music tabs and you will be able to see your computer name in it. Make sure you’re in the right section; you can’t view photos in the video section.
2. When viewing a photo, hit the tri-
angle button to view extra options, like starting a slideshow of images in the selected folder.
3. When listening to music, you can keep it playing in the background by hitting the PlayStation (home) button.
4. You can copy music, photos and videos onto your PS3 hard drive. When viewing a file, hit the triangle button and select “Copy”.

**Xbox Live**

**Xbox 360**

Xbox Live is an online multiplayer gaming platform provided and maintained by Microsoft. To play online on your Xbox you will have to buy an Xbox 360 Wireless Networking Adapter and an internet connection.
1. After connecting your wireless adapter, press the Guide button on your controller, go to Settings, and then select “System Settings”.
2. Go to Network Settings, select your wireless network and enter your password.
   You’re now connected to Xbox Live.

**Stream media**

Just like the PS3 you can also stream your computer data on your Xbox. All you need is the free version of the TVersity software and a Wi-Fi network.
1. The first thing you need to do is make sure that your computer and Xbox are connected to the same network.
2. After you’ve installed TVersity, run it and click on the plus symbol on the top left. Click “Browse” to select the folders you want to stream from your network hard drive.
3. If you have media in incompatible format, TVersity can translate it. Select “Transcode” when needed in the Advanced menu to convert media on the fly. TVersity will automatically start finding and sharing your files over your home network.
4. Go to your Xbox and navigate to the Music, Picture, or Video Library where you will see a new category called “TVersity on [computer name]”. Select it and you will be able to see the media stored on your computer.

**Hubs, switches, routers and access points**

In order to connect computers together on a network, we use a plethora of devices. These include hubs, switches, routers, and access points; each
of them have different capabilities and serve different purposes. Let’s explore each.

**Hubs**

In their bare essence, hubs enable computers on a network to communicate. An ethernet cable is used to plug each computer into the hub, and information is then sent from one computer to another through the hub. One of the glaring drawbacks of a hub is its inability to identify the source or intended destination of the information it receives. As a consequence, a hub ends up sending the information it receives to all of the computers connected to it, including the one that sent it. Moreover, a hub can send or receive information, but it can’t do both at the same time. This makes hubs slower than switches. On the upside, hubs are the least complex and the least expensive of these devices.

Technically speaking, three different types of hubs exist:

- **Passive hubs:** Do not amplify the electrical signal of incoming packets before broadcasting them out to the network.
- **Active hubs:** Perform this amplification. Another dedicated network device which is capable of amplifying the electric signals is a repeater. Some people use the terms “concentrator” when referring to a passive hub and “multiport repeater” when referring to an active hub.
- **Intelligent hubs:** Used to add extra features that are of particular importance to businesses to an active hub. An intelligent hub typically is stackable, i.e. it’s built in such a way that multiple units can be placed one on top of another to conserve space. It also typically includes remote management capabilities via SNMP and virtual LAN (VLAN) support.

**Switches**

The working principle behind a switch is somewhat similar to that of a hub’s. However, switches are capable of identifying the intended destination of the
information that they receive – as a result, they can send that information to only the computers that are supposed to receive it. Besides, switches can also send and receive information at the same time; making them much faster than hubs. If your home network has four or more computers, or you want to use your network for activities that require passing plenty of information between computers (such as playing network games or sharing music), you should probably use a switch instead of a hub. Switches cost little more than hubs.

As with hubs, ethernet implementations of network switches are the most common. Mainstream ethernet network switches support either 10/100 Mbps fast ethernet or gigabit ethernet (10/100/1000) standard. Different models of network switches support differing numbers of connected devices. Most consumer-grade network switches provide either four or eight connections for ethernet devices. Switches can be connected to each other via a so-called daisy chaining method to add progressively larger number of devices to a LAN.

**Routers**

Routers are devices which enable computers to communicate. They have the capability to pass information between two networks – such as between your home network and the internet. It’s this capability to direct network traffic, which gives a router its name. Routers can be wired (using ethernet cables) or wireless. Hubs and switches work well if you just want to connect your computers; however, if you want to give all of your computers access to the internet using one modem, use a router or a modem with a built-in router. Routers also typically provide built-in security, such as a firewall. Understandably, routers are more expensive than hubs and switches.

Home networkers often use an Internet Protocol (IP) wired or wireless router, IP being the most common OSI network layer protocol. An IP router such as a DSL or cable modem broadband router joins the home’s local area
network (LAN) to the wide area network (WAN) of the internet. By maintaining configuration information in a piece of storage called the routing table, wired or wireless routers also have the ability to filter traffic, either incoming or outgoing, based on the IP addresses of senders and receivers. Some routers allow the home networker to update the routing table from a web browser interface. Broadband routers combine the functions of a router with those of a network switch and a firewall in a single unit.

Access points

Access points, also known as base stations, are capable of providing wireless access to a wired ethernet network. An access point can be plugged into a hub, switch or wired router and can then be used to send out wireless signals. This enables computers and devices to connect to a wired network wirelessly.

In principle, access points act a lot like cellular phone towers. Just like you can move from one location to another and still make and receive calls, you can move around and continue to have wireless access to a network. When you use a public wireless network in an airport, coffee shop or hotel to connect to the internet, you’re usually connecting through an access point. If you want to connect your computers wirelessly and have a router that provides wireless capability, you don’t need an access point. Keep in mind that access points don’t have built-in technology for sharing internet connections. So if you have to share an internet connection, you must plug an access point into a router or a modem with a built-in router.

Although very small WLANs can function without access points in so-called “ad hoc” or peer-to-peer mode, access points support “infrastructure” mode. This mode bridges WLANs with a wired ethernet LAN and also scales the network to support more clients. Older and base model access points allowed a maximum of only 10 or 20 clients; many newer access points support up to 255 clients.
Chapter #3

Just Sharing a Net Connection

How to connect two or more laptops and smartphones, in a host of different wired and wireless ways, to share the good ol’ internet as well as your files and folders
In this chapter, we’ll touch upon the most basic of network operations – sharing a net connection. Whether the sharing involves two computers or a computer and a tablet or perhaps even, a computer and a mobile, the underlying principle remains the same. We’ll be discussing the array of options available to you in this realm – wireless, wired, USB and Bluetooth.

Sharing a net connection between two laptops
The wireless way
If you’re using a laptop, you may at some point feel the need to create a quick network connection between two computers or laptops to share some files. Or maybe you may just want to share an internet connection. For this very eventuality, Windows 7 and Vista come with a build-in feature to create a quick ad hoc wireless network connection. What this means for you is that you can connect directly with another computer or laptop without the need of a router.

1. Open the Windows Control Panel, and then click “Network and Internet”.

2. The Network and Internet window will appear. Now click on “Network and Sharing Center”.

![Control Panel](image1.png)

![Network and Internet](image2.png)
3. The Network and Sharing Center window will appear. Click “Set up a New Connection or Network”.

![Set up a New Connection or Network](image)

4. The “Set Up a Connection or Network” dialog box will appear. From the list, select “Set Up A Wireless Ad Hoc (Computer-To-Computer) Network” option and click “Next”.

![Set Up A Wireless Ad Hoc Network](image)

5. Click “Next” again and it will ask you to type a Network name and select the Security settings as shown in the screenshot alongside.

6. Make sure you select a good password. If you don’t know which security type to select, click on “Help Me Choose” link next to it. The default security type is WPA2-Personal. The security key is case-sensitive.

![Giving your Network a name](image)
and 8-63 alphanumeric characters. You can optionally select the check boxes to hide characters for your security key and save this network for future use.

7. After you're done, click "Next", your ad hoc network will become ready for use! A confirmation page shows your ad hoc network settings.

Now in the “Network And Sharing Center” you can choose what to share as you can see from the screenshot alongside.

In order to Share an Internet Connection, click “View Status” next to the connection that you want to share. Now click on the Properties button which you will find under Activity. Click on the Sharing tab and tick the checkbox where it says “Allow Other Network Computers To Connect Through This Computer’s Internet Connection”. Under Home Networking Connection select “Wireless network Connection” and click “OK”.

You’ll see your connection listed under Wireless Network Connection on the other computer. Simply connect from there and you’re done sharing the internet connection.

**The LAN way**

We’ve already seen how to create a quick ad-hoc wireless connection between two
computers. However, not everybody has a wireless card installed in their computers. So now we’ll show you how to create a local area network (LAN) connection between two computers.

1. First of all, you need to go out and buy the straight patch Ethernet LAN cable (make sure that “patch” or “crossover” is written on the cord) and connect them to both computers.

2. Go to “Network and Sharing Center” through the Control Panel, just the way we did while setting up the wireless connection.


4. Now once you’re inside the TCP/IP properties of your computer, click “Use the following IP” and enter 192.168.0.1 as IP address and 255.255.255.0 as subnet mask. Leave the other details blank and click “OK”.

5. Now go to TCP/IP properties of
the second computer and enter the same details except the IP address, which should be 192.168.0.2 and click “OK”.

6. Voila! Now the networks are ready. You might need to restart both computers in some cases.

If you’re looking to share the Internet Connection between two computers, go to Local Area Network properties again and click on the Sharing tab. Here you can select “enable internet connection sharing”.

To share files and folders between the two computers, go to the properties of that file/folder and select Sharing tab. Click “Share” to being sharing it on the network.

**Sharing a net connection between a laptop and a phone**

Want to send a lengthy email but don’t want to type it on your phone? If you have an Android phone and a laptop, you can use your phone’s internet connect on your laptop in a few simple steps.

You can share your mobile internet connection with a PC via a USB cable or via Bluetooth (USB tethering or Bluetooth tethering). You can turn your mobile or tablet into a Wi-Fi...
hotspot and share your connection with up to eight devices at once. Let’s see how to tether using these different connections.

**Via USB**

If you’re running Windows 7 or any recent distribution of Linux, you can tether your computer in a matter of minutes. However, if you have an older version of Windows, you need to prepare your computer to establish a network connection via USB.

1. Connect your mobile to your laptop/PC with the USB cable provided with the mobile and open Settings.
2. Select “Wireless and network”.
3. Choose “Tethering and portable hotspot”.

![Settings](image1)

![Wireless and network](image2)

![Tether your mobile](image3)

![Connection via USB](image4)
4. Check “USB tethering”. Your phone is now sharing its internet connection with your laptop. You’ll see an ongoing notification on the left of your notification bar.

5. To stop sharing, uncheck “USB tethering” or simply disconnect the USB cable.

Creating a portable Wi-Fi hotspot

If you have multiple users who want to use the internet at the same time, you can use your mobile as a Wi-Fi hotspot and connect to eight devices.

1. Go to Settings.
2. Touch Wireless & networks > Tethering & portable hotspot and check the “Portable Wi-Fi hotspot”.
3. You’ll see an ongoing notification on the left of the notification bar. To disconnect, uncheck “Portable Wi-Fi hotspot”.

To configure your Wi-Fi settings open Settings.

1. Touch Wireless & networks > Tethering & portable hotspot. You can configure the Wi-Fi Settings only if the Portable Wi-Fi hotspot is checked.
2. Touch “Portable Wi-Fi hotspot settings”.
3. Touch “Configure Wi-Fi hotspot”.

After the Configure Wi-Fi hotspot dialog box opens, you can change the network name (SSID) that other computers see when scanning for Wi-Fi networks. Secure the network with Wi-Fi Protected Access 2 (WPA2) security with a pre-shared key (PSK) and enter your desired password. Touch “Save” to save and exit.

Via Bluetooth

If your computer has Bluetooth, you can configure your tablet to share its network connection with your computer.
1. To do this, you first need to pair your tablet with your computer.
2. After this is done, you need to configure your computer to share its network connection via Bluetooth. You can do this by making your computer discoverable via Bluetooth and allowing incoming PAN connections. This process depends on the Bluetooth software you use; refer to its documentation for more details.
3. Now, open Settings, touch Wireless & networks > Tethering & portable hotspot and check “Bluetooth tethering”. You’re now sharing your tablet’s connection with your computer. To stop sharing, uncheck “Bluetooth tethering”.
   Although you can tether via Bluetooth, you should prefer tethering via Wi-Fi because it offers higher data transfer rate.
A guide to setting up your very own network through routers, data cards and tethering, which is bound to boost your standing among your peers.

We've already shown you how you can share an internet connection among different devices, and even share different files and folders across the network. In this chapter we'll be showing you how to set up your very own network.
We’ll be exploring the ubiquitous options like routers and data cards. Apart from that, we’ll also tell you about tricks and techniques you might not have heard of, like pocket routers and tethering gadgets.

So let’s get started:

**Using a router for your home**

As we’ve already seen, routers connect networks. We told you in the preceding chapters, that if you want to give all of your computers access to the internet using one modem, you need to use a router or a modem with a built-in router. Routers have a very wide range—from your PC running the good ol’ internet sharing software to zillions of dollars’ worth of systems of specialised hardware and software.

The router is designed to act as an interface between your local network and the internet and take care of most of the more confusing networking options for you. This in itself is quite a headache–alleviator but routers even go a step further by providing firewall protection between the computers on your network and the rest of the internet.

Physically, the router is situated between your laptop and the internet connection or broadband modem. All computers on the local network connect to this router and not directly to the modem. Routers are configured by logging in to them. The router has an IP address, and you use your web browser software, to connect to the router, log in and set the configurations. We’ll now give you a step-by-step guide to connecting and configuring your very own router:

**Connecting your router**

Although it may seem very daunting technically, setting up a router can be a piece of cake. In fact, after it’s set up, you rarely, if ever, have to reconfigure or mess with the router.

Let’s take a look at the hardware side of the router. The only connections you have to worry about are situated on the rear. You may refer to the direc-
tions that came with the router for specifics on how things are set up, but generally the ethernet cables from your PCs hook into the LAN connectors. A single connector is designated for the broadband modem, which also plugs into the router by using an ethernet cable.

Some routers come with on/off switches. Nowadays you just need to plug the router into the wall socket to turn it on. There’s no need to turn off the router unless you’re troubleshooting the network or you plan on not using the network for an extended period; most people just leave their broadband modems and routers on all the time. Another important item you need to locate on your router is its reset switch. It’s probably located on the back of the router. The reset switch is most likely recessed.

The front of the router is far less interesting than the back. The front features a few lamps that flicker as traffic flows into and out of the router, plus perhaps a status light or three.

Setting up your router

Now you’ll learn how to set up a Wi-Fi router to use with your laptop. In general, this process begins by connecting the router to the same computer that is attached to your broadband modem (in this example, your laptop); this allows automated configuration software to obtain the information it needs without any intermediary devices along the way.

Here’s a typical setup:

- The first thing you need to do is turn off the power to your broadband modem. If your modem doesn’t have an on/off switch, remove the power supply to the device.
- Now, connect the power adapter to the back panel of the wireless router.
- Plug this adapter into any AC outlet and make sure that the power LED illuminates.
- Once you’ve ensured that the power LED is glowing, connect an ethernet cable to the broadband modem.
- Insert the other end of the ethernet cable into the WAN (wide area network) port on the back panel of the wireless router.
Insert another ethernet cable between LAN Port 1 (on the back panel of the wireless router) and any available ethernet port on the NIC (network interface card) of the laptop, which you’re going to use to configure the Wi-Fi system.

Shut down the laptop connected to the Wi-Fi router and restart it.

Open your web browser and in the address bar of the browser, type the URL for the built-in setup screen of the wireless router.

For example, type http://192.168.0.1 for most D-Link routers.

Now you may need to log in to the router. The below table shows a list of the standard addresses for setup screens as well as default usernames and passwords from several major makers.

Once you’re “in” the router, you’ll see a web page which is basically the router’s configuration program. You may now refer to the directions that came with the device for the basic configuration of the router. In addition to those directions, you can use your web browser to set various options. Some of the most important ones are discussed below:

- **Change the router’s administrator password:** Pick a strong password. Especially for a wireless router, you don’t want to pick something obvious or easy that your nosy next-door neighbor or a novice hacker will guess. Note that Windows may not even connect to a wireless network that lacks a password.

- **Ensure that the router’s firewall is active:** The firewall most likely is active, but do check, just in case. Use the router’s web-based interface in your PC’s web browser to navigate to the firewall option screen.

- **Set a Service Set Identifier (SSID):** This is the name by which the wireless network is known. Set the encryption for the network (Wired Equivalent Privacy). Make sure that you note down the password! It will be a long string of numbers and letters, and you must enter it exactly to access the network.

- **Selective Access:** You can configure
Setting up Your network

the base station to allow connections only from known computers. You specify this setting by listing the MAC address of the wireless ethernet adapter in each PC.

- **DHCP:** Tell the wireless router to provide IP addresses dynamically for all computers on the network. This is also known as Dynamic Host Configuration Protocol (DHCP).

Congratulations! You’ve now successfully set up your very own Wi-Fi router. The router remembers its settings, so there’s no need to reconfigure it after a power outage. After its setup, you’ll probably never need to mess with it again.

**Networks on the go**

So a wireless modem is only good within a certain range. But what happen when you’re on the go and you want to connect your laptop or tablet to the internet. You’ll be lucky if you can find a Wi-Fi hot spot – but in India, you might be hard-pressed to find one. If you’re traveling by car in unfamiliar territory, for example, Wi-Fi is a not-so-convenient option. So what do you do?

This is where wireless data cards come into the picture. If you’re looking for flexibility, reliability and security, there’s simply no substitute for a wireless data card. It provides access anytime and anywhere to anything you need on the web from your laptop.

**What’s a wireless data card?**

A wireless data card makes use of cellular phone technology to connect your laptop to the internet. What it does is it dials into the wireless data network of your cellular carrier, and your laptop sees this as an always-on connection. This is very similar to your DSL or cable modem at home. Access to the internet is through the network coverage of the relevant telecommunication company provider via Code Division Multiple Access.
Setting up Your network

Access (CDMA), Evolution-Data Optimized (EVDO) or High-Speed Packet Access (HSPA) technologies. In India as well as abroad, all cellular carriers now, offer data cards to meet the ever-growing and ever-changing needs of its subscribers and the array of laptops, netbooks and now tablets.

**Types of wireless cards**

- **Plug-in models:** You have to simply plug these data cards into your laptop. You get them as USB cards and ExpressCards. These ExpressCards are like a smaller version of the older PCMCIA cards they’ve supplanted and have a much better battery life.
  
  You can move these USB wireless cards and ExpressCards from one computer to another, assuming the computers can accept the card type. USB cards are usually recommended, however, because they can be shared between computers and they work on Macs, PCs and even Linux OS computers. Also, many small laptops don't have the room for an ExpressCard slot.

- **On-board wireless data cards:** There are certain data cards which are built into the laptop. This makes them an excellent addition to the mobile gear of people-on-the-go. The only downside is that these cards are dedicated to the laptop on which they’re installed, and so they cannot be shared between devices. They also can be tougher to troubleshoot and are recommended only for true road warriors.

- **Multi-device cards:** The third and the last type of data card is one that can share the same connection to a cellular carrier among multiple devices at once. The pioneer of these devices is the MiFi, about the size of a credit card. You can use it in two ways:
  
  1. You can either connect it directly to your laptop with a USB cable, like the USB data cards mentioned above or,
  2. You can leave it disconnected and turned on. It will then act like a Wi-Fi hotspot for access by as many as five users (although three users is a practical maximum). Note that this use of MiFi cards can be confusing at times and is usually recommended for the computer savvy. Just make sure you remember to charge your MiFi card.

**How does it work?**

A USB broadband card interfaces with the connected computer using a Universal Serial Bus (USB) connector.

- When the device is connected, the computer interprets the device as a
network adapter and the machine’s operating system begins sending network traffic to the device using standard networking protocols.

- When the broadband card receives networking data from the computer, it converts the data into radio waves in order to interface with the wireless broadband carrier’s point of presence or hub.
- Depending on the card’s vendor and the wireless broadband carrier, the frequency of radio waves may vary considerably: some carriers use the 800 megahertz (800MHz) frequency while some specialised carriers use frequencies reaching up to 38 gigahertz (38GHz).
- Wireless broadband employs an advanced data encapsulation method known as Time Division Multiplexing which helps the broadband card balance upstream (upload) and downstream (download) data packet transfer for optimum network and frequency utilisation.

How to set it up
Since many different cellular services offer their own data card, the installation procedure varies from one Data Card to the other. In this section we’ll be describing the most generic way of setting up your own network. You should be able to getting yourself up and running with Wireless Broadband with very few deviations, from what is outlined below:

USB modem setup
1. Connect your Wireless modem to an available USB port on your computer.
2. Once connected, your USB modem will automatically check that the Proprietary Connection software has been installed onto your computer. The first time you connect the USB modem to your computer, the modem will automatically install all the necessary software.
3. The setup wizard will guide you to install the software. Just follow the onscreen instructions to complete the software installation. Then click “Finish”.
4. Double-click on the Service Provider’s Wireless Broadband Icon on your computer desktop or taskbar to launch the Connection software.
5. The Wireless software will locate the Service Provider’s network and will display the available network in the bottom left-hand corner.
6. Once the modem has located the Service Provider’s network, click on the CONNECT button.
7. Congratulations, you’re now connected to Wireless broadband. Open your internet browser and start surfing the internet!
Data card setup
1. If your data card came with an installation CD, insert it into the CD drive of your computer.
2. If your data card didn’t come with an installation CD, insert the data card into a compatible PCMCIA port on your laptop.
3. Your CD or data card will then install the Connection software onto your computer. When instructed, follow the onscreen instructions to install the connection software and complete the software installation.
4. Once the software has been installed, double-click on the Service Provider’s Wireless Broadband Icon.
5. The Wireless software will locate the Service Provider’s network and display the available network in the bottom left-hand corner.
6. Once the modem has located the network, click on the Connect button.
7. Now, open your browser and start surfing the internet!

Other uses
More advanced users can make use of wireless data cards along with a special router, to create their very own DSL-type connection — the data card becomes their ISP. Plug as many as five cards into an 802.11b/g/n router to do this. For example, if you’ve a temporary research site, and you need to connect multiple computers to the internet; you can use the data card’s internet connection and the router to set up the link.

Tethering
We’ve made passing references to tethering before in this book. Let’s take a closer look at what tethering is all about – iPhone tethering as well as Android tethering.

Tethering is a general technique available on many cell phones and smartphones to access the internet. With the right software and data plan from a cellphone carrier, it allows users to connect their smartphone to a computer and use the phone’s 3G internet connection to provide wireless, always-on connectivity to the computer.

iPhone tethering
When you use an iPhone as a wireless modem to provide internet access to a computer or other Wi-Fi-enabled device, like an iPad or iPod Touch, it’s called iPhone Tethering.

thinkdigit.com
Requirements
To use iPhone tethering, you must have an iPhone 3GS or higher, running iOS 4 or higher, with a data plan that supports tethering.

Costs
Tethering often requires a monthly data plan subscription in addition to the standard phone contract. Most major iPhone carriers offer data plans that include tethering.

Connecting
Devices can connect to the iPhone when it’s in tethering mode three ways, via Wi-Fi, Bluetooth and USB. USB is the default method when using Personal Hotspot, but it is easy enough to enable Wi-Fi and Bluetooth sharing, too. We’ll be telling you more about this shortly. Keep in mind that tethered connections are generally slower than broadband or Wi-Fi connections, even if they’re more portable.

Personal hotspot
While tethering is the general name for this functionality, Apple’s implementation of it and the way its onscreen iOS functions are labeled is called Personal hotspot.

Check if tethering is enabled
There are two ways to check if iPhone tethering is enabled on your account.

First, you can log in to your wireless account online and check your plan. Tethering will appear if you’ve added it to your plan.

Another way to go about it, is to check it on your iPhone itself. To find out, tap the Settings icon, then go to General > Network. Scroll down to the Personal hotspot button. If it reads “off or on”, tethering is enabled. If it’s not, the button will read “Set Up Personal Hotspot.”

How to use tethering
1. The first thing you need to do to begin se-
ting up your Personal Hotspot is tap on the Settings icon on your home-screen. Then tap on “General”. Then tap “Network”.

2. In the Network Setting screen, you’ll see a button labeled “Set Up Personal Hotspot” about halfway down the screen. Tap this button. You’ll only read this before setting one up the first time. The next time you do it, it will simply read “Personal Hotspot”.

3. If a pop-up comes up like the one shown alongside, it means that you haven’t added the Personal Hotspot service to your iPhone’s data plan, or don’t already have tethering enabled. In order to use this option, you’ll need to add tethering to your iPhone data plan, as it supplies both – tethering and the Personal Hotspot service. To do this, call your cell phone carrier or add it via your web-based account.

4. Once you’ve added the Personal Hotspot/tethering to your data plan, you’ll see a screen like the one below when you tap on the Personal Hotspot menu on the Network screen.

5. Now in order to start up your Personal Hotspot, slide the Personal Hotspot slider to “On”. If you want to change the password, tap the password field and edit it on the next screen. Anyone wanting to connect to your hotspot via Wi-Fi will need to supply this password in order to gain access.

6. As we told you before the default mode of connection to your Personal Hotspot is USB only. When you turn on your personal hotspot, you’ll see this pop-up asking if you’d like to turn on Wi-Fi and Bluetooth to allow for wireless connections. Tap the Turn on Wi-Fi and Bluetooth button, as you see fit.

Congratulations! You’re done setting up your Personal Hotspot and are ready to let others connect to it.
When other devices are connected to your Personal Hotspot, you'll see a message in blue at the top of the screen or on the lock screen indicating that the Personal Hotspot is active and the number of users connected to it.

Now that your Personal Hotspot has been set up, when you want to turn it on in the future, simply tap the Settings icon and you'll find a new Personal Hotspot menu item at the top of the screen, just under Airplane Mode and Wi-Fi.

**Android devices: Tethering and portable Wi-Fi hotspots**

Just like in the case of iPhone, Android phones also give you the option of sharing your Google Android device's mobile data connection with a single computer via a USB cable or via Bluetooth. This may, however, depend on your model of Android device and your carrier. You may also be able to share your Android device's data connection with up to five devices at once, by turning your phone into a portable Wi-Fi hotspot.

We've already shown you how to share a connection from your Android Mobile to a laptop or tablet, by creating a Wi-Fi Hotspot or tethering via USB or Bluetooth. However there is a small catch – it only works on Windows 7. If you want to tether your Android device via USB to a computer running Windows XP, you must prepare your computer as described:

1. Download the configuration file “tetherxp.inf” to your Windows computer from [http://www.android.com/drivers/tetherxp.inf](http://www.android.com/drivers/tetherxp.inf)
2. Use the USB cable that came with your phone to connect your phone to your computer.
5. Check USB tethering.
6. When Windows’s New Hardware Wizard opens, select “No”, not at this time and click “Next”.
7. Select “Install from a list or specific location” and click “Next”.
8. Click “Browse” to browse to the directory where you installed the configuration file you downloaded in Step 1 and click “Next”. Windows uses the configuration file to configure itself to support USB tethering with the Android phone.
9. When Windows finishes installing the software for Android USB Ethernet/RNDIS, click “Finish”.

You can now use the new Windows local area network connection provided by your phone via USB tethering.

Pocket router

We’ve all been in situations when we felt the urgent need to access internet on multiple devices like laptops, tablets and mobiles. Sometimes a data card is not enough for your networking needs; maybe because you can’t connect it to your phone or your tab. A pocket router is your solution to this problem.

With a pocket router, you can create a secure Wi-Fi hotspot anywhere almost instantly. Weighing around 80 g with a size that can fit in your pocket (hence, the name), these routers offer speeds up to 3.1 mbps.

You can get a pocket router with a Tata Photon or an MTS connection at around ₹5000. Or you can buy D-link DIR-457 pocket router for ₹10,000 and use any UMTS/HSDPA SIM card. Completely portable and with a battery life of about four hours, you can connect five devices (16 for Dlink) to the pocket router.

Let’s look at how to set up a pocket router. Here we’ll be taking a look at the Tata Photon D-link DIR-457 pocket router.
1. First, open the back cover and insert the battery and the SIM card.
2. There are two modes of connection: USB and Wi-Fi
3. You can switch the mode using the selection switch. Once in USB mode, you can connect your router to your computer with the USB cable provided and power on the device. The Connection Manager should start up automatically.

Now, let’s configure the 3G connection.

Go to Settings > Switch to USB Modem ConnMgr

You’ll have to set up a new profile. Click on the Profile button.

Click on the New button to create a new profile.

Select your profile type. You can choose Preconfigured settings or create your own User Defined Profile.

If your service provider isn’t listed in the preconfigured list, choose User Defined Profile and click on “Next”.

Fill in your profile name, phone number, APN, username, password and authorisation type. You can get these details from your service provider.

Click “Finish” and you’re ready to connect.

You can now connect to the internet by clicking on the black connect button, once connected, it will turn green. To disconnect, click on the green disconnect button.

To configure your Wi-Fi settings:
1. Go to Settings > Switch to Wi-Fi and Basic Settings and select “Wi-Fi settings”.
2. Here you can manually choose your SSID and select the security mode.
3. Click on the Security mode dropdown box and select WPA2 security.
4. Enter your desired password.
5. To check your usage, go to View > Usage and select the Current Month tab or the Previous Month tab. You can also control usage using the connection manager.
6. Open the connection manager.
7. Select Tools > Preference and select the Usage tab.
8. After checking the “Limit by Data” checkbox, you can put in a limit on your use. Once you’ve exhausted this limit, you’ll be disconnected automatically.

**Additional features**

Now that you know how to connect to the internet, let’s look at how you can use this pocket router to send text messages to other phones. The D-link router can be used to perform all the text messaging functions that can be done on a mobile phone such as sending, receiving, replying, forwarding and deleting.

1. To start messaging, click on the SMS tab in the connection manager.
2. Click on “New message” to compose a new message. Enter the recipient’s phone number or select it from your contacts stored on your SIM
card. Type in your message and click “send.”

3. To reply or forward a message, select and click on “Reply/Forward.”

You don’t need your mobile handy whenever you want to send a message because the router has its own contact manager which can be used to add, edit or delete contacts.

- To add a contact, click the Contacts button. Now, select “Add” and enter the contact name and the phone number. Click “OK” and the contact will be saved on your SIM card.

- To edit a contact, click the Contacts button and select “Edit”. Make the necessary changes and click “OK” to save your changes.

- To delete a contact, select the contact and click on the delete button. To delete all contacts, click “Select All” and hit the Delete button.

If you already have your contacts in vCards, you can import them here in just a few clicks. Go to Contacts and click the Import button. Select the vCards you want to import and click Open. After the import, a message will display the important contact information. You can also export your existing contacts by clicking the Export button and selecting the destination to save the vCards. Click “OK” to export the cards. A message will be displayed after the transfer is complete.
Welcome to the future of advanced home networking. Gone are the days of cluttered and tangled unattractive wires. Each and every device in your home will be seamlessly connected to one another and you’ll be able to access each and every type of file – photos, music, movies – on any device, from anywhere in your home. With the advent of DLNA, NAS and wireless technology, you’ll be able to control everything remotely, including your media players, torrent downloads, web camera and even your home lights and sprinklers.
Digital Living Network Alliance (DLNA)

In the earlier chapters we introduced you to DLNA and told you how DLNA is a worldwide collection of electronics, computer, and mobile device companies that lets these consumer products connect and communicate with each other and share digital media easily. DLNA makes it possible for you to have a cool networked home and create a digital network that moves with you - from room to room, device to device and moment to moment. You can begin your age of digital living in two simple steps:

1. All you need is a wired or wireless home network, and guess what? You're ready to get started! That's because today's DLNA Certified devices connect, discover and communicate with each other over a home network - like the one you currently have for sharing your broadband internet.

2. Purchase DLNA Certified® products available on the market. Once these devices are connected to your home network, there's virtually no limit to what you can do.

Now all this sounds very cool, but what is it exactly that DLNA allows you to do? Imagine you've just downloaded a movie on your smartphone, but you don't want to watch it on the small screen of your phone. Who would, when you have a 42" flat screen LCD TV, right? So if your smartphone and TV are DLNA certified, what you need to do is very simple:

1. Locate the movie on your smartphone
2. Send it to play on your TV - all done wirelessly.

Or maybe you want to watch a movie in the living room, but the TV with the DLNA Certified® set-top box is in the bedroom and already being used to watch a teary soap saga. Rather than watching something else or waiting to use the TV in your bedroom, you can simply:

1. Access the set-top box
2. Watch your show on the living room TV.

A DLNA Certified® smartphone just might leave you speechless. With your smartphone, you can now:

- **Find, send and play music:** Simply locate your favorite playlist on your smartphone and play it on any receiver, such as your DLNA Certified® wireless speakers or AV receiver.

- **Send and print photos:** You can now access the photos you took earlier in the day on your smartphone and have them printed directly from your DLNA Certified® digital printer - all done wirelessly, of course!

- **Send, view and upload videos:** Just like you we told you earlier, you can send videos stored on your smartphone to view on your DLNA Certi-
_advanced home networking

After that you can transfer and store the videos on your DLNA
Certified® network attached storage (we'll explain NAS in detail later on).

Getting your hands dirty

So now it's time to get down to the basics, and set up the connection that will enable you to do all the cool things we've described above. In this section, we'll be showing you how to connect your LCD television to your home network with a wired ethernet connection.

First of all, you need the following equipment:

1. An internet connection.
2. A router (If you're connecting more than just the TV to your internet connection).
3. An ethernet cable long enough to connect from the TV to your router (or ethernet wall jack).

After you have all of the above equipment, follow these steps:

1. Connect the ethernet cable to your router, modem, or wall ethernet jack.
2. Connect the other end of the ethernet cable to the LAN port on the back of your TV.
3. Press the MENU button, and use the directional arrows to select “Setup”
4. Select “Network”.
5. If Network Type is set to Wireless, select “Network Type” and then select “Wired”.
6. Select “Network Setup”.
7. Select “Internet Protocol Setup” and then select “Auto”.

Connecting the Ethernet Cable

Connecting the Ethernet Cable to the LAN

The Setup Option

The Network Submenu
8. Select “DNS” and then select “Auto”. Most users will select “Auto for Internet Protocol Setup and DNS”. If your network requires you to put in a Manual IP address and DNS Server, enter those settings.
9. Press the RETURN button to return to the Network screen.
10. Select “Network Test”. The TV now tests the network to make sure it’s connected and working properly.
   If the connection test fails, make sure that the ethernet cable is properly connected to both, the TV and the router. Next, power off the TV and unplug the modem and router. Wait for about a minute and then plug the modem and router back in, and then power on the TV. Rerun the Network Test.

   If you have a wireless network, it’s substantially easier and all you need to do is select your network type as Wireless in Step 5 and proceed exactly like before, from step 5 onwards.

**Media servers**

Media Servers have been often touted as panacea to all your file storage woes. But what exactly is a media server?

In its most simplistic sense, a media server is a device that stores and shares media. Now this is a very vague and open definition and encompasses a number of different types of devices. It may be a simple NAS, a home theatre PC running Windows XP Media Center Edition or a commercial web server that hosts media for a large web site. When we speak about media servers in a home setting, we’re usually referring to its role as a collector of a host of information, including but not limited to video, audio, photos and books. These different types of media, irrespective of their origin, are stored on the media server’s hard drive.
In this section, we'll be showing you how to build up your own media server, using your old unused PC. We'll also show you a cool feature that comes with Windows 7, which encapsulates what Media Servers are all about.

**Building your very own media server**

While the market is now being flooded by computer manufacturers coming out with “media servers” to sell to consumers, it's important to know that you don't have to necessarily buy a brand new machine. Instead, you can use cheap (or salvaged) parts to build your own box, as media server hardware doesn't have to be top-notch.

You may have one or two old computers hanging around the house, in a corner, in a basement, attic, etc. just collecting dust. We'll now show you how to build home media servers from this old junk of a computer. Note here that in this short tutorial, we're assuming you have XP running on your old computer. But it should work equally well with any Windows OS.

1. Start by clicking “Start” and “Control Panel.”
2. Select “Network Setup Wizard.”
3. Press “Next” two times and then select “This computer connects to the internet thorough a residential…” and then select “Next.”
4. Enter a name and description for your server and then click “Next.”
5. In the next window, select the workgroup name and then click “Next.”
6. Now, select the “Turn on Windows File and Printer Sharing” option and click “Next.”
7. Make sure the info is right and click “Next” again.
8. On the following screen, select “Just Finished” and then click “Next” and “Finished.”
9. To start sharing, simply create a folder in any directory.
10. Now, right-click on the folder and click “Network Sharing and Security”.
11. When the Security and Sharing window loads, select “Share this Folder on the Network” and “Allow Network User to Change My Files.”
12. Now go to your other computer(s) that you wish to access these files at and click on “Start” and then right-click on “My Computer” and select “Map Network Drive.”
13. Now, click “Browse” and select the name of the home server and click the “+” beside it to expand the options and click the folder that we just created.
14. To access your newly established home media server, simply go to “My Computer” and double-click on the drive you created and you’re in! You should now be able to copy and paste files to your heart’s desire!

thinkdigit.com
Sharing digital media with other computers on a home network with Windows 7

Windows 7 comes along with Windows Media Player 12 which you can use to easily turn your personal computer into a media server to stream music, movies, and pictures to other computers and devices on your home network.

1. In order to start streaming media from your Windows 7 machine you’ll need to turn it on by opening Media Player.

2. In the Library section of Windows Media Player 12, click on “Stream” then click “Turn on media streaming.”

3. Alternately you can also bypass Windows Media Player 12, and do the following:
   a. Open Control Panel.
   b. View All Control Panel Items.
   c. Select “Network and Sharing Center”.
   d. Select “Media streaming options”
   e. Click on the button to turn on media streaming and press “OK”.

4. Now you’ll be able to view all the devices which are connected to
the network and can then select which computer or media device have access to the media.

5. You can also customise the streaming settings by selecting what will be shared and also notice the parental ratings control.

6. Now that we’ve enabled media streaming, it’s time to take a look at what to look for in Windows Media Player 12. On another device on the network open Windows Media Player and under Library you’ll see “Other Libraries” and the available libraries of Music, Video and Pictures available for streaming.

Isn’t this a cool feature? You now have a dedicated computer with a lot of disk capacity to run as your media server. This gives you the freedom to have com-
puters and tablets and laptops, containing less space, connect and enjoy all the media they want.

**NAS boxes**

Remember floppy disks? Yes, those square disks which were quite a rage in the 90’s but now would be hard to find even in an antique store? Historically, floppy drives have been widely used to share data files, but today the storage needs of the average person far exceed the capacity of floppies. Enter Central file servers. They made use of basic client/server networking technologies to solve these data storage problems. File servers have had a long track record of success. However many homes, workgroups and small businesses are not usually in a position to justify dedicating a fully general-purpose computer to relatively simple data storage tasks.

This is where NAS or Network Attached Storage enters the picture. NAS challenges the traditional file server approach
by creating systems designed specifically for data storage. Instead of starting with a general-purpose computer and configuring or removing features from that base, NAS designs begin with the bare-bones components necessary to support file transfers and add features “from the bottom up.”

But wait – here comes the best part! You don’t have to go out and purchase a NAS device. You can build a superior alternative using spare parts left over after upgrading your PC. That’s right folks! You can build your very own NAS with the following parts:

- FreeNAS (Free, [www.freenas.com](http://www.freenas.com))
- ISO recorder (Free, [http://isorecorder.alexfeinman.com/isorecorder.htm](http://isorecorder.alexfeinman.com/isorecorder.htm))
- USB thumb drive
- Motherboard
- CPU
- Case
- Memory
- Videocard
- Optical drive
- Power supply
- One or more hard drives

Now that you’ve got hold of all the requisite parts, the first step in the process is to build the physical NAS box. However, since this is no different from assembling a PC, we’ll skip ahead to the installation of the operating system. We’re going to walk you through the finer points of setting up a FreeNAS-based network storage device on your very own.

**Burn the FreeNAS ISO to CD**

First of all make sure your motherboard’s BIOS is configured to boot from a USB device, as we’ll be installing the operating system to a thumb drive.
FreeNAS is based on FreeBSD, which is a Unix-like open-source OS. FreeNAS is different from both, Linux and Windows. You should therefore bear in mind that using the OS as the backbone of your file storage is going to wipe out anything that might be on the hard drives you use. But there’s also a bright side to it – FreeNAS itself requires no hard drive space for installation.

Download the FreeNAS ISO and insert a CD in your burner. If you don’t already have software capable of burning an ISO image to a CD, download and install the free utility ISO Recorder. Once you’ve burned the image, put the CD in your NAS box’s optical drive, restart your computer and boot FreeNAS from the CD.

**Install FreeNAS on a USB thumb drive**

We’re going to set up our NAS to boot from a USB thumb drive so we don’t limit our upgrade options.

- Plug a thumb drive into the NAS box’s USB port when the FreeNAS Console Setup menu appears.
- Choose the menu item “Install/Upgrade to a hard drive/flash device, etc.”
- When prompted next, choose the first option: “Install ‘embedded’ OS on HDD/Flash/USB.”
- Choose the optical drive containing the FreeNAS ISO image and hit Enter.
- Now select the USB thumb drive on which you want to install the OS.

**Configure your network settings**

- After you’ve installed the operating system on the thumb drive, remove the CD and reboot your NAS box.
- When your NAS box has rebooted, choose the first item from the Console Setup menu “Assign Interface”.
- Unplug the NAS box’s ethernet cable and choose the OS’s Auto Detection option.
- When prompted, plug the ethernet cable back in and hit the Enter key.
- You’ll get a message that reads “Detected link-up on interface XX,” where “XX” is the name of your ethernet interface. Hit the Enter key again.
- The next screen will read “Configure OPT interface.”
- Choose the option that reads “Finish and exit configuration” and hit the Enter key.

Now the next thing we need to do is set the LAN IP address. However before we can do that, we need to reboot the computer. You can do this by typing the number 7 and hitting Enter to reboot the computer.
When the machine has finished rebooting, choose the second item from the Console Setup menu “Set LAN IP Address”.
When prompted whether you want to use DHCP, choose Yes unless your network is set up with static IP addresses.
At the next prompt, select “AutoConfiguration for IPv6.”
The OS will then give you the IP address that’s been assigned to the NAS box. You can ping your NAS box in order to ascertain if it has joined your network,
You can manage the settings of your NAS box using your web browser. Just type the NAS box’s IP address into your browser’s address bar. (The default user name is “admin” and the password is “freenas”.)

**Configure your drive**
Once you’ve logged into the web GUI, you’ll want to take a shot at a few important configuration steps:
- Start by clicking General (in the left-hand menu stack, under the System heading) and change the desired information in the large pane on the right.
- Change the name of the NAS.
- Set the correct date, time, and time zone.
- Create a unique username and password.
- Click the Password tab, type in the existing password (“freenas”), and enter your new password in the two boxes provided. You’re now ready to prepare your hard drive.
- Go back to the left-hand menu and choose Management under the Disks heading.
- The plus sign inside the circle on the right-hand pane indicates that you can add an element to the NAS.
- Click the plus symbol and all the drives in your system will appear in the window next to the disk heading. Choose your hard drive.
- Make sure that the value for “Preformatted file system” is set to “unformatted” before you click the Add button; then click “Apply Changes”.

**Format and mount the hard drive**
Are you ready to wipe your drive? What you need to do, is return to the “Disks” heading in the left-hand column of the NAS box’s administrative options and choose the Format option. From the dropdown menu select your hard drive and enter a volume label. Accept the remaining default
choices: “File System: UFS (GPT and Soft Updates),” “Minimum Free Space (8),” and “Don't Erase MBR (unchecked).” Click the Format Disk button.

Before you can access a drive, you have to mount it. So go back to the left-hand Disks menu and click “Mount Point”. Click the circled plus sign, select “Disk” from the dropdown Type menu, and choose your hard drive from the dropdown Disk menu. Select “EFI GPT” from the Partition menu and UFS for the File System value. Click the Add button when you’re finished. An OK message in the Status window indicates that the drive was successfully mounted.

Enable services and create shares

We need to be able to access our NAS box using computers running Windows, so it’s essential that we enable the SAMBA networking protocol on our NAS box. Look in the left-hand column for the heading labeled Services and click the CIFS/SMB menu item. Place a check mark next to “Enable” in the main window but leave all the values at their default settings. Click the Save and Restart button.

Now that you have SAMBA up and running, you’ll have to create one or more network shares. This will allow your remote computers to treat the NAS box’s hard drive(s) as though they’re a local resource – which is why we made the NAS in the first place.

So click the Shares tab in the “Services: CIFS/SMB: Settings” window and click the circled plus button. In the screen that appears next, share a name, add a comment describing the purpose of the share, set the path and click the Add button. Click the Apply Changes button on the next screen. When you’ve finished configuring FreeNAS, click the Backup/Restore button to create a backup of your configuration. You should now be able to find your NAS and your newly created shared folders listed in your network places.

How to stream from your NAS box

Now that your new NAS box is ready to go, getting all your movies and photos to stream to your media device of choice is extraordinarily easy. Here’s how you do it.

- To get started, head into the web configuration for your NAS and go to Services > UPnP.
- Click the Enable checkbox on the right-hand side and give your UPnP server a name.
Under “Database Directory”, click the “...” button and browse to a folder on your NAS where you want the UPnP configuration file stored (it doesn’t really matter where this is).

Then, head down to Content and click the “...” button to point FreeNAS to the folders you want to share.

You can add multiple folders from all over your NAS, and it can stream them as long as they contain movies or music. Some devices, like the Playstation 3, may require you to transcode your higher-definition videos, so check the “enable transcoding” box if necessary. Then hit “Save”. If you head over to your UPnP device and search for servers, you should see that your NAS pops up, and you can browse your media folders and watch those videos on your TV.

**Torrent boxes**

Another really cool tool in your networked home is a Torrent Box. Simply put, a torrent box allows you to queue, manage and share all your torrent data via a network connection. This means that you can just leave your old PC running Torrent, in the corner chipping away at your downloads and seeding away, whilst you’re out working on your laptop. You won’t need a monitor once you’ve set up the box, which means you can put it anywhere it will fit.

**Setting up**

1. It’s always best to start with a fresh operating system, so format and reinstall your chosen OS on the PC’s hard drive.

2. As you’re going to be using the machine to store data, you’ll need a fairly large hard drive depending on your plans. However if you’re using the box as a go-between (before transferring your downloads to shares or backup locations) then space is not so much of an issue.

3. It’s important to remember to format the drive on which you’ll be downloading your torrent data to NTFS, and not the older FAT32 file system. NTFS will allow you to download files greater than 4 GB, a constraint when using FAT32 devices.

4. Make sure you have at least one shared and accessible location from which to access the data. Simply create a folder on your main download drive, right-click and choose “Share”. This is where all your downloaded data will go.
Installing uTorrent and the web UI

1. Download the latest version of uTorrent from its official webpage and boot it up. You may want to adjust a few settings, including your connection settings for optimal download and upload performance.
2. Hit Ctrl+P to bring up the Preferences dialog or you can even access it from the Options Menu.
3. Within the General tab check “Start uTorrent on System Startup”. This means if you ever need to restart or move your box you can resume your torrents by simply turning it on.
4. Under Web UI, check “Enable Web UI” and create a username and password.

**Remote Access**

1. Make sure your torrent box is turned on, connected to the network and running uTorrent. Using any machine on your network visit `http://192.168.0.x:port/gui/`

   Here “x” is the computer’s location on the network and ‘port” is either your uTorrent client’s connection port or alternative listening port.

2. You’ll be prompted for the username and password you created under uTorrent’s web UI preferences. Log in and you'll be presented with uTorrent’s web user interface

3. From here you can add, remove and manage your torrents as well as update your preferences. It’s quite literally uTorrent within your web browser.

   Accessing your web UI is all well and good on your network, but what about when you’re not at home? For this you need a static IP or DynDNS in order to connect from outside of your home network. This is not a problem if you happen to be a computer geek! But since you’re reading this, we’re going to assume you’re not one.

   This is where uTorrent Remote comes in. Whether you want to simply add a torrent to your download queue, manage which files are downloaded...
within a particular torrent or even change your client settings, µTorrent Remote gives you full access to µTorrent from anywhere.

1. Make sure you’re running µTorrent 3.0 or above. If you’re not, install the latest version and boot it up.

2. Click on the µTorrent Remote button on the Menu Bar. Doing so will quickly take you to the “Remote” section in µTorrent’s preferences. Now you need only add a username and password:

3. You should see “Status:Accessible” under these boxes shortly after you fill them in. If not, try another username/password combination. When you do see “Status:Accessible” you’re done.

4. Head over to https://remote.utorrent.com/

5. You’ll need to move your mouse around to help encrypt the communications, and then you can enter your username and password.

6. Everything you can do in µTorrent itself you can do here, as well.

A torrent box is a very clean new way to put your old technologies to use and it costs nothing to set up. If you’ve already got an existing media center or file server, adding torrent functionality is another simple step you can take to streamline your home setup. Remote access gives you the freedom to peruse from afar and have your downloads ready for you and the rest of your network, the moment you get home.

**Remote everything?**

Confession time! How many of you have ever wished you could use your tech to keep an eye on your home while you’re gone? Yes, we’re all guilty of harboring that particular fantasy. So, we’re going to tell how you can do this – without an expensive dedicated setup!
All you need is a web cam. In this section, we’ll show you how to use your everyday tech to set up a motion-detecting camera in your house, so you can keep an eye out for intruders, mischievous pets, or even pestering kleptomaniac roommates.

What we’re going to do is install a web cam software like Yawcam software to utilise any standard PC web cam (USB or built-in) as a surveillance camera for free. If you have a laptop, all-in-one desktop PC or a monitor with a built-in web cam, you won’t need to spend any money on this project at all.

Next, we’ll strengthen the coverage of your surveillance setup by adding whatever spare iOS or Android gadgets you have handy – old phones, iPod Touches, anything with a camera – to the mix. In order to exercise this particular option, we’ll use a few handy apps that let you turn your mobile work gear into an extra pairs of eyes for as good as free.

So, what are we waiting for? Let’s start.

**Use your PC web cam to monitor your home**

2. Plug in your web cam and have drivers installed.
3. When everything is hooked up properly, launch Yawcam.
4. Add your camera by clicking the “Settings” menu and choosing “Device”.
   
   If your web cam is built into your PC – as is the case with those found on most laptops and all-in-one desktops – select the “Integrated
Camera” option. If you're using a USB-connected external web cam, select “Change to” and choose your USB camera out of the lineup.

5. YawCam will open a new Preview window with your camera’s video feed.

6. From the main Yawcam window, click on the Window menu and select “Motion Detection”.

7. You can fine-tune the motion-detection features in the Settings menu, where you can confine the motion detection to a certain area of the camera image, tweak the sensitivity level, and more.

8. Click the Enable button on the left-hand side of the window. Now motion detection is running!

9. From the Motion Detection window, click the Actions tab and check
“Send E-Mail”; then click the Settings menu button. Here you’ll need some information from your email provider – specifically, the SMTP (Simple Mail Transfer Protocol) settings. If you’re a Gmail user, you can find Google’s SMTP settings by following these instructions.

10. Next, check “Attach image” at the top of Yawcam’s Email Settings menu, specify the email address you want Yawcam to send it to, and tweak the flood control settings to make sure you aren’t completely inundated with camera spam. Click “OK” and you should be all set.

**Use your iOS or Android smartphone as a wireless network camera**

Here’s how to use your iPad, iPhone, iPod Touch or Android phone/tablet as a wireless network security camera:

1. Download the app “Wireless Camera ($2)” app, from the App Store and open it on your iOS device.

2. Wireless Camera uses iOS’s built-in Web server features to start a website on your local network that you can access by pointing your browser to your gadget’s local IP address.

3. Open Wireless Camera and tweak the settings to suit your personal preferences. Then check “Motion Detection and Add Timestamp” and check “Enabled” at the top to start the recording.

4. From here, you can position your iOS device wherever you like, and it will begin streaming a video feed that you can access in http://[your device’s local IP address].

5. Navigate to the web interface and click “View Recorded Images” to see how your camera is doing.

   Note that if you want to access your video feed from outside your home network, you’ll need to delve into your router’s Network Address Translation and port-forwarding features to point incoming traffic toward your iOS gadget.

Alternatively, you can use a spare Android handset as a wireless network camera:

1. Download an app called Motion Detector Pro by MVA. Motion Detector Pro is free in the Android Market.

2. From there, you can configure your ideal motion detection threshold, which comes in handy for separating the motion that you want to see (burglars, pets doing cute things, roommates eating your snacks) from the noise (trees, shadows, moths, etc.).
3. You can also specify a phone number or email address to receive the incoming snapshots.

4. Next, press “Show advanced settings”, and you can configure Motion Detector Pro to start up when you send it a specific text message. Define particular zones in your camera feed that you want it to monitor and turn on a stealth mode that closes the app as soon as the phone is touched.

5. Once you’ve finished tweaking the app, activate the motion detection and you’re good to go.
In this last chapter, we’ll be taking a look at the various apps available on the Android and Apple Store, which lets you connect to a laptop or a tablet and perform a number of cool tricks. We’ll also be introducing you to VPN (Virtual Private Networks) which lets you access your data on a network while you’re on the go. Finally we’ll be touching upon a very important topic – ensuring the security of your wireless networks.
A look at apps: iPhone and Android

Sharing an internet connection is okay, but do you know that you can use your phone to control your computer? Or use your computer to send text messages via your phone using your computer? By installing a few innovative apps, you can make full use of the potential that your phone has to offer.

First let’s take a look at some useful Android apps.

Android apps

Wi-Fi Keyboard
This tiny app gives you the freedom to use your computer’s keyboard to type your SMS. After you’ve installed the app, go to Settings > Language and Keyboard and check “WiFiKeyboard”. Touch “Select Input Method” and select “WiFiKeyboard” to set it as your default keyboard.

To use this, you must connect your phone and computer to a Wi-Fi network. Once connected, open your browser and go to http://110.226.125.189:1111. If you want to type a message, open New Message on your phone and while the text box is highlighted, start typing in your browser to see the text in your phone.

To go back to your default keyboard, long press the text field and select “Input Method” and select your default keyboard.

Dropbox
You might already use this to share files with your friends on your computer but now you can use it to share files on your phone too. Sign up for an account if you already don’t have one and install the app. If you share any file in Dropbox on your computer, you can use your phone to access it anywhere and vice versa.

Once installed you can see all the files you’ve shared on your computer and you’re free to download as many times as you want.
You can also choose to upload files from your phone to view them later on your laptop.

**Firefox**
You’re browsing the web on your computer and you find an interesting link which you want to share on whatsapp or just want to save it on your phone, what do you do? Mail it to yourself? The mobile Firefox app offers a better solution. You can sync your browser to your computer and have access to your browser history, bookmarks, passwords and open tabs from any device. It also has Add-ons to customise your browser. Now you can bookmark links on your computer to access them on your phone with just a few clicks. To sync your phone:

1. Go to Firefox Options and click on the Sync tab
2. Click on “Set up Sync and Create a New Account”.
3. After you’ve filled your details, you’ll see a security key, save it.
4. Once you’ve created an account, click on “Add a Device”.
5. You’ll see a window that asks you for a code.
6. Open Firefox in your device and go to Preferences. Under the Sync menu, touch Connect and you’ll see the code you have to enter.
7. Enter the Code. Once the code is verified your device will be synced.

thinkdigit.com
8. You can choose what to sync from the Sync tab
9. If you're a Chrome user, you'll have to wait a while because the official app for Chrome (Chrome to Phone) is not yet available in India.

**Remote Gallery 3D**
Imagine you've just come back from a trip clicking a lot of photos on your mobile. But if you want to show many people, you'd have to transfer them to a computer or pass your phone around so that everyone can get a good
NetworkiNg and Beyond

Remote Gallery 3D is a free app that can show your pictures on your PC/Mac/TV with just one tap from your Android phone. You don’t need a USB cable or any other software, just your regular browser and a Wi-Fi connection.

Just install the app from the market and connect your PC and mobile to a Wi-Fi network. Run the app and follow the simple instructions to view the pictures on your PC. You can choose to download or edit them and even secure them with a password.

µTorrent Remote
How many times have you left home leaving your torrents on only to realise later that they used up all your bandwidth? µTorrent Remote is a nice little app that will allow you to monitor and manage the µTorrent downloads on your PC or Mac from anywhere you get an internet connection. You can use µTorrent Remote to add, remove, start, stop torrents and check your download progress and check your RSS feeds and start downloads on the go. Use your mobile browser to find torrents and they will automatically be added to your home µTorrent. All the completed downloads can even be shifted directly back to your Android device for local playback.

PhoneMyPC
Finally an app that lets your phone control your PC no matter where you are! PhoneMyPC is an exciting tool that lets you use your PCs from any Android device as long as you have an internet connection.

All you need to do is download the app from the market for a fee and install a small software on your PC and you’re ready to go. After you’ve installed the PC app, enter your desired username and password and click “Connect”.

Once you’ve done this, run the app on your mobile and go to settings.
Enter the same username and password and your mobile will be connected to your computer and you’ll get a notification on your computer. Your mobile will display your computer screen and you can take complete control of your PC. You can create and delete files, play music, install software etc. You can also attach a camera to your computer and monitor your children or listen through an attached mic.

**iPhone apps**

**Remote**
Remote is a cool Apple app that lets you control iTunes and Apple TV using your iPhone, iPod touch, or iPad over your Wi-Fi network. You can choose playlists, songs, and albums just like you would in iTunes. You can also control every aspect of your Apple TV user interface. You can quickly type using your device’s keyboard instead of clicking each letter on the Apple TV screen. You can pause, rewind, fast forward, shuffle and control volume on each speaker independently. You can create and edit playlists in iTunes and even control Shared Libraries on iTunes and the new Apple TV.

*thinkdigit.com*
Mobile Mouse Pro
Tired of using your touchpad? Convert your iPhone into a mouse. Mobile Mouse instantly transforms your iPhone or iPod touch into a wireless remote for your computer so you can sit back and use this remote to surf the web, browse your photo library or control your music player from the comfort of your couch. Using the built in accelerometer, it translate your hand motions into mouse movements on your screen. You can also use it in trackpad mode; in this mode you can control your mouse with a single finger just like your laptop touchpad. Mobile Mouse uses an innovative application notification system to let the iPhone know what program you’re running at any time and show the appropriate keys for that program. So if you’re using a media player, it will show you the start, pause, next buttons and if you’re using it for a presentation using powerpoint, it will show you the next and back button. It also has unique multitouch features like two finger scroll, two finger tap, swipe left/right with four fingers, swipe up/down with fouringers etc. This app is available at the Apple App Store for $1.99

Mocha VNC
Mocha VNC lets you control your Windows PC or Mac using your iPhone or your iPad. This app works similar to PhoneMyPC and lets you view, create and delete files.

X-Plane REMOTE
If you like gaming and play X-Plane then this is a must-have app for you. With this app you can use your iPhone or iPod touch as wireless joystick for your desktop computer flying X-Plane. This can be very useful if you’re ever traveling and do not have you joystick with you, you can simply use your iPhone or iPod touch as a wireless joystick. You can control the throttle, flaps, speedbrakes, landing gear, and brakes on your desktop or laptop just as you do with your joystick.

Virtual Private Network
If you need access to your data on a network while you’re on the go, you need a Virtual Private Network (VPN). VPN technology lets a computer using a public internet connection join a private network by establishing a secure tunnel between that machine and the network. It’s commonly used in offices where employees need to access the data on their network from remote locations.
Windows 7 has a preloaded VPN client and it's very easy to set up a VPN in it.
First let’s see how to build a VPN.

**Setting up a Virtual Private Network**

1. Open the Network and Sharing Center.
2. Click “Change Adapter Settings” in the left-hand menu
3. Press Alt key to get the menu. From the File menu, select “New Incoming Connection”.
4. You’ll now be able

**Selecting your users**
to see a list of users you can allow to connect to your computer. Select the users you’d like to give access to and click “Next”.
5. Check the “Through the internet” checkbox.
6. Select the TCP/IPv4 protocol
7. Finally, click “Allow access”; you’ve now set up an incoming VPN connection.
8. Make a note of your IP address as you’ll need it to connect to your VPN.

**Connecting to a VPN**

1. Now that we know how to set up a VPN, here are step-by-step instructions to connect to one.
2. Click the Start button and type VPN in the search bar and then select “Set up a virtual private network (VPN) connection”.
3. Enter the IP address or domain name of the server to which you want to connect.
4. You can choose to set up the connection, but not connect by selecting “Don’t connect now” or leave it blank and click “Next”
5. Enter your username and password and click “Connect”.
6. To connect, click on the Windows network logo on the lower-right part of your screen; then select “Connect under VPN Connection”.

**Security**
In past chapters, we saw how to connect all your devices to one network. Since all your data is on this network, it’s extremely important that you secure it. An unsecured network can give any hacker access to your data and passwords.

To get started, you’ll need to log in to your router’s administrative console by typing the router’s IP address into your web browser’s address bar. Refer to your router’s manual for this address (usually 192.168.1.1)

There are a few simple but effective ways to secure your network.

**Enable WPA2 encryption**
The new WPA2 encryption offers better security than its predecessors – WEP and WPA. You can choose the type of security when you create your network. Make sure you enter a strong security key.

![Choosing security while creating an Ad Hoc network](image)

**Changing passwords**
This is the simplest way to protect your network. Keep changing your passwords regularly. Although no password is foolproof, you can build a complex password by using numbers and special characters. You’ll have to manage two passwords – Wi-Fi and router. Most often we forget to change the router password. The default password is “admin” which is pretty easy to guess. Make sure both your passwords are strong and do not use birthdays or pet names as passwords.

**Limit your connections**
If you always use the same number of devices, you should set your router to
allow limited number of connections. Dynamic Host Configuration Protocol (DHCP) makes it easy for your network to manage how many devices can connect to your Wi-Fi network at any given time, by limiting the number of IP addresses your router can assign to devices on your network. Open your router administrator settings and go to DHCP settings. Here you can change the number of client leases as per your requirement. You can keep the number one higher than the devices you have for guests.

**Block WAN requests**
You can conceal your network from other users by enabling the Block WAN Requests option. Once this feature is enabled, your router won’t respond to IP requests by remote users, preventing them from gleaning potentially useful information about your network. Also disable remote administration privileges through the router administrator so no one can change your router settings wirelessly.

**MAC filtering**
Every device that can connect to a network has a unique MAC (Media Access Control) address. It’s composed of six pairs of alphanumeric characters. Using the MAC address you can allow only specific devices to connect to

![Image of Firefox Sync setup](https://thinkdigit.com)

Your network information
your network. To know the MAC address of a Windows PC, open the Command Prompt. Type `ipconfig /all` and press Enter to bring up your IP settings. Here you’ll be able to see the details of your network along with the MAC address under the name of Physical Address.

If you’re on a Mac, open System Preferences and click “Network”. From there, select Wi-Fi from the list in the left-hand column, click “Advanced” and look for Airport ID or Wi-Fi ID. If you want to find the MAC address of a handheld or any other device, check the user manual. You can also find the MAC address of this device if it’s connected to a network. Your router displays a list of devices connected to your network along with their MAC address in the router administrator.
Join the forum to express your views and resolve your differences in a more civilised way.

Post your queries and get instant answers to all your technology related questions

one of the most active online technology forum not only in India but world-wide

JOIN NOW www.thinkdigit.com
Transforming Individuals into Networking Professionals

What a Certification Can Do for You
Get Practical Knowledge – Break into the Networking Industry – Increase Technical Skills – Gain Competitive Edge

The D-Link Academy Advantage
Experienced Instructors – Hands on Training – Comprehensive Learning – Reputation for Excellence – Affordability

Why Choose D-Link Academy?
• A practical learning and certification program
• A quick path towards networking certification
• An affordable learning program

Certification:

D-Link (INDIA) LIMITED
Kalpataru Square, 2nd Floor, Kondivita Lane, Andheri (East), Mumbai - 400059.

For more information, please visit our website http://academy.dlink.com or email - Sudhanshu.Ojha@dlink.co.in